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Introduction to Digital Workflow Best Practices 
Because they can be targeted to practically any medium, digital images have greatly expanded the pos-
sibilities for artists to document and publicize their work. They have also become a required part of 
the submission process for many shows and exhibitions. By explaining the principles of the technology 
and introducing some of the software needed to work with these images, this workshop will provide a 
foundation for taking advantage of these valuable assets.

The goal of this workshop will be to develop a workflow that optimizes and preserves the quality 
of your original image files and helps you get to them when you need them. We will try to describe 
ideal practices that will, in the long haul, give you the most flexibility for the least effort. At every level 
of work, compromises may have to be made because of budget or time constraints. I hope to give you 
enough understanding of the process to help evaluate how you can best apply your time and budget to 
get the results you need. Be warned of several old adages though: there is no free lunch, you get what 
you pay for, quality does not come cheaply, and time is money. They are as relevant in the digital world 
as ever. 

 
GIGO: Garbage In, Garbage Out
This is another old adage that is relevant. The better you do at capturing your master image, the better 
your derivatives will be. You will need to gauge the energy you need to put into this step, as not all of 
your work will require the same level of documentation. Keep in mind that if your documentation is for 
a competitive position in a show or for a grant, your competitors will be making the same decisions you 
are, which include whether to hire a professional or not. 

One of the myths about digital images that can stop you at the very first step is the myth that Photo-
shop can fix most problems with an original. The truth is that Photoshop can fix many problems, and 
Photoshop, in the hands of a skilled worker, can improve bad photography, but in the spirit of offering a 
guide to best practices, I’d like to offer a list of problems that Photoshop can’t solve, and which can only 
be done best at the time of image capture. 

Too much exposure, or too little.
Focus or depth of field issues.
Lighting that fails to articulate form or texture.
Capturing with a file format that provides too much compression.
Capturing with insufficient resolution.
An image that is blurred by camera or subject motion.
A dirty or low quality lens.
Digital noise caused by capturing at low light levels.

This is a partial list, but looking it over should give you time to pause and consider your own capa-
bilities as a photographer, your interest in gaining these skills, or your ability to pay for the required 
equipment. Each of these failures will produce the “garbage in” that will assure you of a less than ideal 
derivative.

Targeting and Re-Purposing
Re-purposing is an awkward word that describes the process of using one digital image in several dif-
ferent later applications. Because digital images can be copied exactly, there is no loss in copying, so 
when you need to use an image in its original form, there is no problem in doing so—you re-purpose 
the image by copying it. Often though, the original form is not the ideal form for a later use. A web use 
requires an image of much less resolution than one that is needed for print. An rgb image headed for an 
inkjet  printer must first be converted to cmyk mode to be printed by the offset process. The process of 
converting the original to an ideal form for each of these different uses is called targeting. It requires you 
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to take control of each of three main image parameters—image size, color space, and image mode—to 
produce a derivative that is best suited to a subsequent use.

Although this may seem complicated, re-purposing and targeting are one of the real beauties of 
working with digital images. In the days of film, making a copy of an original was a laborious venture 
that always produced a copy that was inferior to the original. With digital images, a few keystrokes 
or clicks of the mouse produce a copy that is identical. That copy can then be modified to produce a 
derivative that suits the new use. 

This ideal situation depends on several conditions, the most important being that the original image 
remains in its original condition and that it can be located to use as a master. Satisfying this condition is 
the topic of a field of practice called digital asset management. 

Here is the basic workflow I’d like to suggest, starting with the capture of the image of the original 
artwork. It is deceptively short and simple. The important part of the diagram is the fact that once you 
have a master image, all other derivatives come from this master. Although this is same basic process 
used when working with film, there is a difference that is easy to forget when you are working digitally. 
The ease with which you can rename, copy, re-sample, transmit, and edit images comes at a cost. With 
that same ease you can write over an original file or accidentally delete it. A power failure or mechani-
cal failure can render a hard drive unreadable. This makes it very important to establish and abide by a 
logical workflow.

If you read no more of this paper, try your best to follow these guidelines.

1. Back up your work.

2. Use the RAW file format for images if you can. If you can’t, set your camera to shoot tif. If 
you can’t shoot tif, use the largest, finest jpeg setting your camera will allow.

3. Use a tripod, set your camera manually.

4. Don’t jpeg a jpeg. (re-compress a compressed file format)

5. Back up your work.

6. Preserve the integrity of your master images at all cost.

7. Name your files uniquely. Use an image database to find them.

8. Convert your RAW images to the .dng format—Adobe’s open source digital negative—for 
long-term access to your raw files and built-in access to your non-destructive  adjustments.

8. Back up your work.

Subject
2D or 3D

Original
+

Edited Master

Backup Copies

Web

Prints

Show Application

Gallery Catalog

Capture

Output Derivatives
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Imaging Principles: Color Models, Pixels, Channels, and Image Depth

Color Models
Color models are strategies to describe an image so that it can be stored and processed as digital 
data. Although there are many color models, the most important for still images are RGB and 
CMYK. RGB is an acronym for Red, Green, and Blue, the three primary colors. By adjusting the 
proportions of these three colors most other colors can be created. CMYK stands for Cyan, Magen-
ta, Yellow, and blacK, the four colors of standard offset printing ink. (k so that it can’t be confused 
with the b in blue.) Most of the time you will work with the RGB color model, which is suitable for 
viewing on computer screens, projecting with digital projectors, or, because the conversion is built 
in to their drivers, printing with an inkjet printer. An RGB image describes a wider range of colors, 
or gamut, than a CMYK image, making it more suitable for use in a master file.

Pixels
A digital image is made up of pixels arranged in rows and columns. Each pixel represents a small 
part of the image, and is represented digitally by a number representing values along a scale from 
light to dark. An image’s image size is the measure of its pixels, measured in the horizontal and 
vertical axes, so that a 1200 x 800 image is 1200 pixels wide by 800 pixels tall. If the pixels are close 
enough together, they read as a smooth continuous tonal range and you don’t read them as individ-
ual dots. This pixel density or resolution determines how smoothly the values in an image appear. 
The image size, or absolute number of pixels in the image, determines how large the image can be 
displayed at a given resolution. 

Resolution is measured in pixels per unit of length, for us, pixels per inch. To print smoothly, most 
printing applications require a resolution of at least 240 ppi. For web use or other screen‑based im-
ages, the target resolution is 72 ppi. Some basic math will lead you to the conclusion that for a given 
image size, a screen-based image will be rendered larger than one that is properly sized for print, 
and a printed image requires a larger image size to appear at the same length and width as a web 
image. 

The easiest way to understand the interaction of resolution 
and scale is to imagine the pixels of an image mapped to a rub-
ber band. The rubber band has a fixed number of points marked 
on its length that represent the image’s pixels. As you stretch the 
rubber band, its length increases and the marks get farther apart, 
but they do not increase in number. When the pixels are very 
close together they appear as a continuous tone. If the rubber 
band is stretched and the pixels get too far apart they no longer read as smooth values. This is why 
you cannot arbitrarily enlarge a digital image without having it look “blocky”, and why it is impor-
tant to capture the maximum resolution you are capable of when you photograph your work. 

240 pixels / inch

100 pixels / inch

10 pixels / inch
1 pixel / inch
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!  Note that it is possible to display any image size at any resolution—1200 ppi, for 
example. It is only when you also specify a physical dimension with that resolution that 
you run into the potential for a limitation. A an image that is 600 pixels by 400 pixels will 
appear 1⁄2 by 3⁄8 at 1200 ppi, but would need to be 4800 by 3200 to reproduce at 4 x 3". 
Unfortunately it is common to specify only part of this equation—the resolution—without 
specifying the size, so a request will be made for images “at 300ppi.” This is not enough in-
formation to know how to fulfill the request. Likewise, a request for an image that is 5 x 7 
fails to specify the resolution and can’t be fulfilled without additional information. 

Channels
A channel is the part of an image’s data that describes one particular aspect of an image’s color 
model. In a grayscale image there is a single channel that describes how light or dark a pixel is. An 
rgb image is made up of three channels, each holding the value of Red, Green, or Blue for each pixel. 
A cmyk image has four channels, one for Cyan, Magenta, Yellow, and blacK ink. Every channel 
contains a full set of information for each pixel in the image.  

Several image formats (.tif, .psd) can also hold additional channels that are used to store infor-
mation about how to display an image. Often called alpha channels, these are used to hold instruc-
tions for displaying only part of the rectangular image or to save masks and selections you build in 
Photoshop. 

Image Depth
Image depth or bit depth is the size of the binary number that stores an image’s pixel information. It 
affects the final quality of edited images. The smallest possible depth is in a black-or-white image, 
which has an image depth of one bit. The pixels in this image are either black or white. Grayscale 
and color images are displayed and printed with 256 steps, or an image depth of 8 bits, per channel, 
yielding the possibility of just under 17 million different values for each pixel. This may seem like a 
lot of values, but because of the fact that each of these values is visible in final prints, there are times 
when this is not enough values to prevent banding and other artifacts. 

When corrections are made to an image’s lightness or contrast, original values must be rounded 
to the nearest whole value in the editing process, resulting in the possibility for skipping levels that 
become visible in a smooth gradation. The solution is to work with your images at a higher image 
depth. A 16 bit image theoretically (but not quite practically) provides another 256 steps inside each 
single 8 bit step. This eliminates most of the rounding issues associated with 8 bit images, but comes 
at the cost of doubling the file size. Many scanners provide 16 bit images, as well as cameras that will 
save a raw file. In all cases where image editing will need to be done, a larger image depth is better 
than a smaller one. These Photoshop histograms show the difference between editing in 16 bit color 
and editing in 8 bit color. The gaps in the right hand histogram are from rounding to the nearest 
whole number of steps when making adjustments. They will print as a “step” in a smooth gradation.

8 bit steps

16 bit steps

Original 16 bit image After adjusting in 16 bit After adjusting in 8 bit
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Practical Matters: Compression, Color Space, File Naming, and Editing

Compression and File Size
File size, measured in kilo-, mega-, or even giga-bytes is the space your image take up on your hard 
drive. You can see this number by selecting the file with Windows Explorer or Mac’s Finder. A file’s size 
in influenced by its image size, image depth, and the number of channels it contains. An image that is 
twice as wide will also be twice as tall, and therefore have four times as many pixels, with a correspond-
ing quadrupling of file size. The file for a 16 bit image will be twice as large as one for a same-sized 
8 bit image. An RGB image file is three times as large as a grayscale image, and a CMYK image file 
is one third larger than an RGB image. These factors combine in every permutation, so that a 16 bit 
CMYK image has eight times the file size of its grayscale counterpart. Providing a way to store the large 
amount of data is one of the real challenges to working with digital images.

One scheme for reducing file size while preserving the number of pixels in an image is compression. 
The most common way to do this is to save your file in the JPEG file format. The good side to this is 
that the images take up less space. The down side is that each time you compress an image you destroy 
some part of the image’s original data. Many digital cameras save their images in the jpeg format, al-
lowing you to fit more images on a memory card. If you edit these images and save your results you are 
compressing the compressed image even further. If hard drive space is a concern, using JPEG images 
for derivative uses is a good alternative, but it is never acceptable for edited master files that have mul-
tiple future uses.

If you can avoid shooting jpeg originals, you should do so by setting your camera to the “tiff ” or 
“raw” setting for important work. If you can’t avoid jpeg originals, use the finest setting your camera 
has—either “fine” or “superfine” along with the largest file size. Then treat these files as you would a 
negative. Don’t edit them, don’t save over them, and don’t erase them. When you want to make adjust-
ments, open the file, make your adjustments, and then save them in an uncompressed format (.tif or 
.psd) to use as masters.

Color Space
A color model tells us the method by which an image will be translated into bits and bytes, but it does 
not tell us how those numbers will be translated into something we can see. This is the job of a color 
management system and the profiles that describe the color space of each monitor, printer, or scanner 
that you use. Because these devices’ capabilities vary, their color spaces also vary. The color manage-
ment system in your computer must translate from one color space to another to ensure that colors 
appear consistent between each device. There are three areas where you can change color space settings, 

After three rounds of jpeg compression          

Uncompressed tif        
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for better or worse—at the capturing and editing stage, when viewing on the monitor, and when print-
ing. While there may be ways to get to good results without paying attention to these color settings, 
you will probably arrive at them with the trial-and-error method. If you then hand your file over to 
someone with different settings they will see very different results. The goal of color management is to 
standardize the color appearance of your images across different systems and devices.

Working or Editing Space. With all the color translating that must be done, there must be some start-
ing color space for making these translations. This space must be large enough to include all the colors 
that will be translated to, including the color space of the monitor. This is the working space, sometimes 
called the editing space or simply referred to as the embedded rgb profile. This can be chosen in some 
cameras, so if you have this choice you should choose a large space. Adobe RGB (1998) is generally 
preferred because it is larger than most monitor spaces and includes the space of practically all print-
ing inks. If you can set this on your camera it will allow you to capture and work with more detail in 
the darker areas of your image. You should also change to this as your working space in Photoshop’s 
settings. (Edit > Color Settings. The original default is sRGB.) This setting determines which profile is 
embedded in your files by default.

Monitors. Every monitor, even when new, reacts differently to the color signal sent to it. To get 
consistent and standardized results you must calibrate and profile your monitor. The utilities built into 
your system will get you close and are a huge improvement over ignoring calibration altogether. But 
to correctly profile your monitor you need a hardware calibrator and the accompanying software. This 
has become considerably more affordable and easy, but comes as another cost of consistent results. I 
worked for many years without a hardware calibrator, using Macintosh OSX’s Display Preferences and 
a patient and sensitive eye to calibrate visually. Changing to a hardware calibrator produced a notice-
able improvement in consistency, and is especially useful when working across several systems.

Printers. Every printer has different ink and lays it down in different proportions. It is absorbed at 
different rates into different papers. This leaves an almost limitless set of combinations for outputting 
the colors. To bring control to this process, you must standardize these conditions. Part of the challenge 
is to have an accurate color profile for your paper-printer combination. Probably more important (be-
cause they will give you bad results even with a good profile) is your ability to reproduce the appropri-
ate settings for your printer. If you use the paper recommended for your printer by the manufacturer 
you will probably already have decent profiles on your system. To set up your file for printing you need 
to tell the printer driver what kind of print media to use, (plain paper, glossy, matte) what resolution 
to print at (photo quality, fine, draft) and other options that you’ll need to repeat exactly for consistent 
results. You can save and name these setting within the driver to help you repeat them. 

You also need to know whether your printer is managing color or if your printing application will 
manage it. With applications like Photoshop, you can specify that Photoshop will manage the color and 
then preview the results on your monitor, a process called soft proofing. If Photoshop manages your 
color, you need to make sure that color management is turned off in the printer driver. If it seems like 
everything else you’ve done is right you may be managing color twice!

File Naming
On your hard drive, images are stored in files, and files are placed in folders. If you place a file into a 
folder that already contains a file of the same name, you will write over that file. (Your operating system 
should give you a warning first.) The primary function of a filename in any workflow is to prevent this 
from happening. Although many people give other functions to filenames, in the long haul it is the task 

Working space profile 
Adobe rgb(1998)

Working space profile 
sRGB

Monitor Profile Inkjet printer profile CMYK profile
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of protecting files from being overwritten that is the most important. If you are just starting out it may 
make sense to name your files by what the subject is. (puppy1.jpg, puppy2.jpg…) If you have just a few 
files, you can take this approach, but it won’t take long before you bump into its limitations. You will need 
to consult your computer to find the last puppy image before you know what to name the next one un-
less you keep each batch in a separate folder. If you keep them in separate folders you will not be able to 
consolidate them without renaming the files. If you have images of other subjects they will all have to be 
managed in the same hands-on manner. 

A better approach is to find your images by some other means and let filenames simply do the job of 
keeping images from being overwritten. It also helps if you can devise a system that can be automated, 
and which a computer will help you keep organized. Here is the simplest I’ve found, based on the fact that 
time does not repeat itself.

Most workflow management software will automate this renaming scheme, and all operating systems 
will arrange these filenames in chronological order. If you work with others who use this scheme on the 
same computer, you could also add some other identifier, such as your initials, either before or after the 
number. (Is it more important to find this work by date or by author?) The beauty of a scheme like this is 
that you do not need to know anything about pre-existing files (what was the number of that last puppy?) 
and you can use it on any computer you have access to. All you need to know is the date that you created 
the image, which, if you set the clock on your camera, is embedded in the file.

Non-Destructive Editing
As noted in the section on image depth, making adjustments to a file causes pixel data to be rounded 
to the nearest whole step. This can cause degradation of the original image quality even though it is not 
yet visible in a print. If the same file is then adjusted again, addition errors will accumulate and eventu-
ally you will be able to notice a decrease the image quality. (Permanent damage is also done when you 
sharpen, apply filters, or do retouching to an image.) At that point there is nothing that can be done with 
that file to restore it to its original state. This method of editing an image is called destructive editing, and  
until a few years ago this was a limitation you simply worked with by preserving your original files and 
making copies for each derivative. As you can imagine, if you have a lot of original images and generate 
lots of different derivatives, you will end up with many, many similar versions that will make organization 
a challenge and hard disk space scarce. Eventually software developers and hardware manufacturers put 
together a better method to manage this process.

Non-destructive editing is a strategy that preserves the integrity of the original image file and draws 
upon it in its un-edited state to make derivatives. This is the workflow described and advocated here. The 
core of this method is the reliance on metadata, “data about data,” to store information about changes 
you make to your original file’s appearance separately from the actual image data. Derivatives are made 
by combining the original image with the adjustment metadata to produce a file that is targeted for a new 
application. Although this method of working was built around the use of “raw” camera files, applications 
like Adobe Lightroom apply it to other more fragile formats such as .jpeg files. This allows you to view 
your changes without actually applying them to the original file. The application then lets you control 
every aspect of the exported derivative while keeping your original in tact. 

Within Photoshop you can practice non-destructive editing by always making your adjustments with 
adjustment layers instead of making them to the original image layer. This gives you the flexibility to 
change the adjustment layer later or simply turn it off without affecting your original image. The intro-
duction of smart objects extends the non-destructive editing principle to the application of filters and 
sharpening, allowing you to revisit these settings in the future without the normal destructive side effects.

20081023-001.tif
yyyymmdd-nnn.ext
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Tools

Here is the hard pill. Just as you need tools to build a house or work on a car, you need tools to create 
and edit images. To create professional quality images, it helps to have professional quality tools, and 
these are not inexpensive. Here are a few guidelines, with the understanding that you will eventually get 
what you can afford and make decisions that best suit your goals.

Hardware
You will need a camera and computer system. You may want other things as well, but without these you 
will not be closing the loop between documenting your work with digital images and using the images 
you create to promote yourself “at will” and “on demand”.

Camera Equipment. A skilled photographer can make almost any kind of camera work. For most 
people though, including skilled photographers, you will be frustrated until you are working with a 
single lens reflex camera, which allows you to look directly through the lens as you compose your im-
age. Cameras at this level also allow an ease with making manual adjustments that is not available in less 
expensive point-and-shoot cameras. This is crucial, for you will need to be able to have fine control over 
focus and exposure if you expect to produce usable images. Camera manufacturers continue a race for 
the most megapixels on their sensors, but the truth is that for several years now there has been plenty 
of file size in even less expensive cameras. Larger file sizes can be enlarged more, but take considerably 
more hard drive space. Six megapixels will satisfy most promotional needs. Twelve is overkill for all but 
poster size images.

The least expensive of these cameras often come bundled with an inexpensive zoom lens. Some of 
these are fine, some are just plain bad. My feeling is that you are better off buying just a body along with 
a better quality lens. 

Regardless of what you get, you can improve your results with a tripod. It is hard to think of doing 
serious work without one, for besides its motion stopping qualities, if you are hand holding a camera 
you must give up your framing and focus to check your exposure and composition. This is particularly 
important if you are using a point-and-shoot camera, since it takes considerable effort to operate it in 
manual mode.

Computers. A few years ago it took a specially equipped computer to do imaging work, but the 
technological gigabyte race has meant that most machines are capable of what you will need. Where 
you will need to pay more attention is in the video capability of the computer and the size and quality 
of the monitor. In these, you will get what you pay for, and if you expect high-end results, you’ll want to 
put some extra cash here. CRT monitors are now history, so you will be looking for an LCD screen that 
measures around 19” to 22”. More important is the resolution of the screen, in this case meaning the 
number of pixels that will fit on it. The more pixels, the finer the image and the more real estate you will 
have for your image and all of the palettes you use when working with imaging software. Consider 1600 
pixels wide a minimum, 1900 if your wallet has not gotten too thin already.

With any computer, you’ll need lots of memory and storage. Two gigabytes is a realistic minimum for 
RAM. For hard disk space, this depends on the amount of data you are storing. Whatever that amount, 
keep in mind that you will want to back up on a separate device, so you will always need 2-3 times the 
storage of what it seems like you’ll need. Be warned! Don’t neglect this.

Windows or Mac, Mac or Windows? I have used Apple computers since 1985, and have not been 
disappointed in the ease with which they handle image-related tasks, and especially color management. 
At this point though, it seems like either platform will do the job. While Windows is the predominant 
system overall, Apple is the most-used system in the graphics and printing world. I feel that you are bet-
ter off using the tools you are comfortable with unless you have a compelling reason to change. 

Software
Finally, a short note about software. Adobe’s suite of imaging products is the choice of practically all 
professionals, and it’s what I have used for the past seventeen years. Just like there is a steep learning 
curve for users of software, there is a learning curve for those who design systems for digital imaging. 
At this point nobody else even comes close to understanding the needs of imaging professionals. Just as 
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important, Adobe has standardized the language of digital imaging and color management, which for 
years has suffered because that language varied from application to application. If you plan on com-
municating with others about your images, if you plan on learning more about digital imaging, or if you 
plan to have images printed by a service bureau or an offset printer, you should plan to work in what 
has become the industry standard. That said, few people can afford every upgrade and version. Work 
with the version you have until a need arises for a newer version. There will be other things to spend 
that money on. Not long ago I would have advised you to get Photoshop first, then other applications as 
the need arises. Lightroom throws a wrench into this logic because it can do so much. I still think you’ll 
need Photoshop, but depending on your needs, you may be able to start with Lightroom. 

If money is tight you may also want to try Adobe Elements, a lite version of Photoshop with a brows-
er that resembles Bridge. It will allow you to learn many of the tools and techniques without spending 
nearly as much money, but you will give up the ability to work with 16 bit images. If you are just starting 
out, this may be all you need to discover whether you have the temperament for this kind of work.

There is also the possibility of using the free software that comes with your digital camera. I have 
used both Nikon’s and Canon’s, and must admit that both make me appreciate the money I’ve spent on 
Photoshop. You may not be so spoiled.

Other Software. Sadly, there is still a list of tasks to perform that require software assistance. I am only 
going to mention one, since it is the most important. You will need some kind of Backup Utility, for 
automating that process. (See below.) This keeps track of which files have had changes made since the 
last backup so you don’t have to move your whole archive every time.

Digital Asset Management
Browsers and Databases
Managing a few dozen images is easy. Managing thousands of image files is much more challenging. As 
noted in the file naming section above, with hundreds or thousands of images, it is enough for a file-
name to do the job of making sure each image has a unique name. The rest, finding images, is best left to 
an image browser or database. 

An image browser, such as Adobe’s Bridge, the browsing function in Elements, or the browsers that 
come with most digital cameras, scans folders on your hard drive and presents you with small thumb-
nails of them in a view that resembles a contact sheet. You locate images visually by knowing where on 
your hard drive the image you are looking for is stored. All browsers offer a way, usually just clicking, to 
open the image file easily once you have located it. 

The main difference between browsers and databases is that browsers 
search folders for all readable files. Databases must have files added to them, 
or imported, before they appear. Browsers have different capabilities, and 
some come close to database functionality, offering ways to search for images 
by searching for words that appear in the image’s metadata. Like the set-
tings information that preserves image adjustments, this is information you 
embed into a file to make it searchable later. You can do this from Photoshop’s 
File > File Info dialog. Once you’ve done this you can save the information 
and apply it to other images, either from within Photoshop, with Bridge, using 
Lightroom, or even some third party databases such as Microsoft’s Expres-
sions Media (formerly iView Media Pro.) It also allows you to tag your files 
with your contact and copyright information. This metadata is the basis for all 
future searches in most other applications, so diligence here will be repaid. 

Lightroom combines the function of an image database with the function of an all-around, non-
destructive, image processing utility. With it you can embed metadata, make image adjustments, create 
web galleries, and print—contact sheets, packages, or finished prints. One feature of databases is that 
they allow you to store your images in any way that makes sense, and then set up virtual Collections of 
images that appear and behave as though they are in the same folder. By “pointing” rather than making 
copies, you are able to have images in many Collections without increasing the storage space on your 
hard drive. This also means that when you update your master image, it is updated in all Collections. 
Apple’s Aperture has similar functions, though it is limited to the Macintosh platform. 

Photoshop’s File Info
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Backing Up Files
All hard drives fail. Period. This is a good thing to keep in mind if you are walking around with your entire 
portfolio of images on your laptop. If your career depends on the documentation you have of your work, 
preparing for the inevitable hard drive failure needs to be part of your working routine and budget. Your 
strategy should take into consideration the fact that 
you are worried about several kinds of calamity. 
The first is media failure, which you can guard 
against by having multiple copies. The second is 
loss due to a catastrophe—theft, fire, flood. You 
guard against this by storing copies in multiple 
locations. Finally, you must, if you’re in this for the 
long haul, guard against obsolescence. You do this 
by moving everything to different media before the equipment needed to retrieve that data disappears.

If your image archive is small, you can back it up on optical media—dvds. Buy the best you can, because 
cheap ones can fail within a few years. Check www.wilhelm-research.com for the latest testing results. Dvds 
that contain a gold layer in their coating have been the most stable in the past, all other things being equal. 
If your collection is large, you will be backing up to external hard drives, and rotating them in a way so that 
you are protected from both media failure and catastrophe. This is a time consuming venture, so it will be 
worth your effort to set up an automated routine. 

Resources
As you will discover when you put this information into practice, we have really just scratched the surface in 
this introduction. Much of what you’ll need to know you will find out by reading and researching. Here is a 
list of some other resources that will take you well beyond the basics. There are a lot of resources for learn-
ing Photoshop, both in books and online. The best of the online tutorials, for Photoshop and other creative 
software, comes from lynda.com. Searching Amazon.com will give you a long list of Photoshop books, so I 
have listed only the current version of the one I’ve read. 

Real World Photoshop CS3, by Bruce Fraser, David Blatner, and Conrad Chavez. Peach Pit Press, 2007. I’m 
attracted to the entire Real World series because of its no bells-and -whistles approach. 

Real World Color Management, by Bruce Fraser, Chris Murphy, and Fred Bunting. Peach Pit Press, 2003. For 
all but the most compulsive, this is the last word.

Real World Camera Raw CS2, by Bruce Fraser. Peach Pit Press, 2005. (Later CS3 edition with Jeff Schewe.) 
Camera Raw is the window that pops up when you try to open RAW files with an Adobe application. If you 
don’t have Lightroom, this is the gateway to Adobe’s non-destructive editing environment. 

The DAM Book: Digital Asset Management for Photographers, by Peter Krogh. O’Reilly Media, Inc., 2005. Al-
though this is not a brand new subject, it is new to those of us who are not information technology special-
ists. This is the first thorough look from an IT layman’s eyes.

The Adobe® Photoshop® Lightroom™ Book: The Complete Guide for Photographers, by Martin Evening. Adobe 
Press, 2007. This is Adobe’s authorized guide. I’ve noticed that version 2 has a different author. 

http://www.updig.org, Universal Photographic Digital Imaging Guidelines, this is the professional’s list of 
best practices, for both creators and users. 

http://www.wilhelm-research.com, Image permanence researchers and reporters. Their reports cover both 
print and digital media.

There is much more information available. Much more.

Working Files Second Level Backup: External HD
(Catastrophe)

First Level Backup: Mirrored RAID
(Media Failure)

Daily Alternate Fridays
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Application Cook Book

Here are a few recipes to help you think about re-purposing for different applications of your images. 

Submissions
Submitting your work digitally is usually done so that it can be displayed to a panel of judges on a screen 
or projector. Good submission guidelines will tell you the height and width limitations of your submis-
sion in pixels, which will probably be geared toward display on a projector. To make this change you 
can Image > Image Size in Photoshop or File > Export in Lightroom. Decent, recent projectors handle 
as many as 1200 pixels across, so in most cases images for projection can be sized to 1200 pixels wide by 
800 tall. If you set a resolution, use 72 ppi, the default standard for screen-based images. Unless stated 
otherwise, most submission guidelines accept jpegs. Converting to and saving with an sRGB color space 
will assure least-common-denominator color compatibility, and will leave you in good shape even if the 
images are shown on a web browser. 

By the way, the worst submission guidelines give the size in megabytes. Because jpegs are commonly 
used for submission, and because they compress to varying file sizes depending on the subject matter, you 
will not know how to prepare to this kind of requirement without trial and error or an application that 
compresses to a target file size. (These applications do so by leaving the image quality as an open variable. 
Beware.) When specifications are not clear it’s important to ask for clarification.

Presentations
If you are preparing images for a Power Point or Keynote presentation, size them as close to the size of 
your presentation as you can to keep loading time quick and storage space low. Building slightly larger 
would be preferable to building too small, and would allow you to move your presentation to a higher 
resolution projector—1200 x 800 maximum for all but the highest resolution projectors, or the full size of 
the monitor if that’s where you’ll be viewing. Use the sRGB color space for compatability with any system.

Web Sites
Images for the web are sized at 72 ppi and must be prepared or converted to the sRGB color space before 
saving as jpegs. If you are building your own web site, you will know the exact pixel dimensions you need. 
If you are building for another web site, you’ll need to ask or follow the instructions sent to you. Since 
sRGB is the default color space of the web, and since all web browsers assume the default, you can save 
web images without a profile if they’ve been prepared in sRGB. This will save a little file size and speed 
download time. 

Desktop Printing
Most inkjet printers require around 240 ppi for best results. More data than this will be discarded, less will 
be interpolated (invented, or guessed at by the software) up to the needed resolution. Keep in mind that 
large prints are viewed from more distance than small prints, so that less resolution is not such a terrible 
thing unless you also want razor sharpness at nose length viewing distance. (It’s not just digital images 
that have a hard time meeting this requirement. Remember film grain?) Work with RGB images, and use 
a large color space like Adobe RGB(1998) or ProPhoto RGB. Try to manage your color from Photoshop, 
(and remember to turn color management off in the printer driver if you do.) If you are combining image 
with text it would be worth considering a page layout program such as Adobe’s InDesign.

Offset Printing
Offset printing requires CMYK images, but the conversion from RGB to CMYK is not a straightforward 
issue. Your best bet here is to get the help of your printer or graphic designer and simply deliver RGB files 
that have enough resolution to print. The rule of thumb is 1½ — 2 times the halftone screen ruling. If you 
don’t know what this is you’ll need to ask. Part of the updig guidelines recommends that you accompany 
your files with a proof to indicate correct color, so if you have a hard copy that shows what you expect 
make sure that you send that with your job. 


